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Introduction
The 861 has been designed to give the very highest
sound quality in a wide range of systems and to
provide playback for all the sound formats currently
available.

The technology in 861 is the most advanced; it is also
designed to be flexible in the future. The card-based
construction and use of flash memory for the built-in
software mean that we expect to be able to keep your
system up to date, or to evolve as your requirements
change.

861 Documentation
This 800 Series System Guide is not yet available.
However, the Meridian 800 Series dealers are fully
trained in Meridian surround systems.

This sheet supplements your 861 User Guide and
provides some items you or your dealer need to be
aware of.

Most of the information in this sheet will be in the 800
Series System Guide when it is available.  Please
return the enclosed form to register your 861 purchase.
We will send you the System Guide with any updates
as soon as it is ready.

861 Built-in software
The 861 is a very advanced audio computer. The
software that controls 861 and the DSP programs that
process and decode the audio are held in a re-
programmable ‘flash’ memory.

At any time the software inside 861 can be updated
by connecting the 861 to either a personal or laptop
computer – more details are given later in this
supplement.

It is Meridian’s intention to make appropriate software
updates available through its support network.

Software updates may be necessary to allow the
addition of new cards, new DSP functions, to expand
functionality of the whole installation or to correct minor
bugs under warranty.

We recommend that you take the dealer’s advice
about whether or not updates are appropriate to your
application.

Product Configuration Software
The 861 is a sophisticated device that offers a very
large number of options to the installer – and therefore
excellent all-round performance in a wide range of
applications.

Because there are so many things that can be
customised in an 861, we have chosen to use a
computer to assist in setup.

The Meridian Product Configuration Program is an
exciting departure for high-end audio. The advantages
of this approach become obvious as the setup
proceeds – and in particular in the way the setups can
be stored either as User Types or as computer files for
backup.

Types and User Types
All Meridian products use the Type method of resetting
the product back to one of several pre-programmed
factory configurations.

Typing the product clears all settings you may have
made in Calibration or by using the 861 Store or Assign
keys. Typing also re-inserts a suite of previously stored
settings or factory default settings. These settings can
cover a large variety of things – ranging from input and
output assignments, to detailed menu settings for each
format + source combination.

To learn how to use Type, please refer to the 861
User Guide.

If you do not want to lose all the settings in your 861,
they can be first stored as a file in a computer using the
Product Configuration Program described later.

Your dealer may have created one or more User
Types for you. The advantage of this is that you or the
dealer can rapidly switch between a number of pre-
determined options during installation, and you can
have the security of being able to restore the dealer’s
settings at any time. User Types are created and
installed using the Product Configuration Program.

Labeling
The back panel of each 800 Series card typically has
the inputs and output sockets numbered, for example
as D1, D2 etc. Beside each socket there is a white
label area in which you can write the assignment in a
way that helps you remember which is which.

The 861 is supplied with a number of self-adhesive
pre-printed labels so that the inputs and outputs can be
neatly marked to avoid writing on the product itself.

Taking time to fix the labels will help a great deal in
the future – especially if you have more than one card
of the same kind.

The labels can also be safely removed and changed
at a later date.
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Standard input connections
A standard 861 is fitted with:

• One analogue input card IA00 with inputs labeled
A1 through A6.

• One digital input card ID10 with inputs labeled D1
through D6, O1 and O2.

• One Video-switching card VS00 with inputs
labeled V1 to V4 and S1 to S4.

The factory Type settings give a standard assignment
of these inputs which is described in the table below.
These assignments may already be suitable to your
needs.

Source Audio In Video In

CD D1 Last Valid

Radio A2 Last Valid

LP A1 Last Valid

TV A3 V2

Tape 1 A4 Last Valid

Tape 2 D4 Last Valid

CDR D3 Last Valid

Cable O2 S3

DVD D2 S1

VCR1 A5 V1

VCR2 A6 S4

LDisc O1 S2

If an RF00 AC-3 Demodulator card is fitted, then the
default for the LD audio input will be the RF card.
Connect the RF input and either the optical or digital
input.

If any other optional input cards are fitted, they are not
accessed as part of the standard Types and the 861
will need to be configured to use them.

Standard output connections
Analogue systems
A standard analogue system uses two OA00 analogue
output cards. These cards are probably pre-labeled #1
and #2. OA00 #1 (nearer the centre of 861) has the
master oscillators engaged and is used for the front
channels.

Digital Theatre
A standard Meridian Digital Theatre uses an OD10
digital output card. At this time there should not be
more than one of these fitted. For additional
subwoofers, or mixed installations one analogue output
card OA00 will be used. The connections in these
cases are given in the following tables.

Analogue speakers

Speaker Output

Left Main OA00 #1:  1

Right Main OA00 #1:  2

Centre OA00 #1:  3

Subwoofer OA00 #1:  4

Left Side OA00 #2:  1

Right Side OA00 #2:  2

Left Rear OA00 #2:  3

Right Rear OA00 #2:  4

Digital speakers

Speaker Output

Left Main OD10 #1:  1/2

Right Main OD10 #1:  1/2

Centre OD10 #1:  3/4

Subwoofer OA00 #1:  4

Left Side OD10 #1:  5/6

Right Side OD10 #1:  5/6

Left Rear OD10 #1:  7/8

Right Rear OD10 #1:  7/8

Connecting a Theatre System
For more details of connecting a Meridian Theatre
system, please refer in the interim to standard training
materials and/or the installation manuals for 519, 565
or the DSP speakers. Some of this material can be
found at Meridian’s website:
http://www.meridian-audio.com.

Configuring a Digital Theatre
Installers please note. The 861 has been designed to
be the default Controller in a Meridian Digital Theatre
system.
Therefore, when you do an Autoconfigure procedure
(press Clear in Standby) the 861 will become system
Controller and the Master Speaker will be set as Non-
controller.
This may not be what you prefer for infrared control. In
such cases the system controller needs to be setup
manually.



Meridian 861 Supplement

Registered trademarks: “THX” and “THX Cinema” Lucasfilm Ltd; “Dolby”, “Pro Logic” “Dolby Digital”and “AC-3” Dolby Laboratories Licensing Corporation;
“Ambisonic”   Nimbus Records Ltd;  “Trifield” Trifield Productions Ltd; “Meridian”, “Boothroyd Stuart Meridian” “LipSync”and “Meridian Digital Theatre”
Meridian Audio Ltd; “DTS” Digital Theatre Systems Inc.; “DVD” Toshiba and the Ten Companies; “Windows”, “Windows 95”, “Windows NT” and “DOS”
Microsoft Corporation; “MPEG” MPEG Organisation.

Using the Configuration Program
Overview
Setting up an 861 with the Product Configuration
program is easy.

861 settings can be stored on disk and permanently
stored in the product as Types so that they may be
recalled later.

The 861 stores information about which combination
of cards is fitted. This allows, for example, the setup
program to only allow inputs to be selected from cards
that are fitted.

To set up a new 861 you would typically follow these
steps:

1. Install the software with the setup discs. (See
'Program installation').

2. Run the program from the Start menu.
3. Select a Serial Port: View/Options. This will

usually be COM1.
4. Connect the RS232 Cable.
5. Switch on the product. Fetch the settings,

including the information on which Cards are
fitted, from the product with the Fetch button on
the toolbar. (See ‘To fetch the current settings’)

6. Double Click on Surround Controller 1.
7. Click on Owner and fill in your name.
8. Save As your name: Press the Save button on

the toolbar. This is now your file that you can
keep for reference. (See ‘To save settings to a
disk’)

9. Double Click on Settings. Give this settings
‘Type’ your name also.

10. Click on the icons to customise the settings to
match your system (See 'Using the Windows 95
program'):

• Speakers:
 -Layout
 -Sizes (run Calculator if necessary)

• Sources
• Setup
11. Store the settings to the product - File/Store to

Products /Everything. (See 'To Store Settings
in the 861'.)

12. Leave the 861 connected to the PC.
13. Calibrate the speakers with the 861’s Calibration

(See User Guide).
14. Listen to the system and store any Presets

required .
15. If required, Enter Gain/Sub Setting mode to set

the Analogue input sensitivities and the Sub
Crossovers (See User Guide).

16. Load the calibrated settings back to the
computer with the Fetch button on the toolbar.

17. Save the calibrated settings: File/Save
 

System requirements
To run the Product Configuration Program, you must
have a computer running Windows 95 or Windows NT
4.0, with a 100Mhz or faster Pentium class processor,
at least 16MB of RAM and 5 MB of spare hard disk.
The computer must have a spare serial port, capable of

running at 38400 baud. A suitable null-modem serial
cable is supplied.

Note: 861 internal software can be updated using a
program which only requires DOS and a serial port.
(See ‘The FUPLOAD program’.)

Program installation
The setup program will have arrived on floppy disks
containing an installation program.

To install, insert disk 1 into the floppy drive of your
computer, and from you ‘Start’ menu, Run ‘a:setup’.

The program will then install itself, to a directory called
‘c:\program files\Meridian\Meridian’.

Upgrading
If you are given an updated version of the program,
follow the instructions that come with it.

Uninstallation
Use the Windows Seetings program ‘Add and Remove
Programs’ to uninstall the Product Configuration
Program.

What the software package contains
The package will contain some of the following:

• MERIDIAN.EXE  – a windows-based application
that creates configurations, User Types and that
transfers settings between the computer, the
product, and files on disk. It can also install new
built-in software in the 861. It may also be used to
configure a 561 Surround Controller.

• FUPLOAD.EXE – a DOS program, which can also
install new built-in software in the 861.

• *.DLL  – various application extensions required
by MERIDIAN.EXE

• 861_xxx.MFU – these files (if present) are
Meridian Flash Upload images, and contain built-in
software for the 861.

• *.MSF – these are Meridian Settings Files and will
contain settings for the 861.

Running the software
To run the software, click the Start button on your
desktop, then go to Programs. Click on ‘Meridian
Product Configuration.

The first time you run the software on a computer:
1. Go to the ‘View’ menu and select ‘Options...’
2. Chose the serial port you intend to use to

communication with the 861, e.g. COM1.
3. Click ‘OK’.

Once made, this setting will be remembered and only
needs changing if you want to use a different serial
port.

The setup program can also be started by double-
clicking an .MSF (Meridian Settings File) file.
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To fetch the current settings
You can extract the current settings from an attached
Meridian 861 so they can be edited or saved to disk.

1 Select ‘Fetch from products’ on the ‘File’ menu, or
click the ‘Fetch’ icon.

 To load settings from a disk
 You can load a settings file from disk.

1 Select ‘Open’ on the ‘File’ menu, or click the
‘Open’ icon on the tool bar.

 To save settings to a disk
 To save your settings to disk:

1 Select ‘Save’ or ‘Save As...’ from the ‘File’ menu,
as appropriate.

 To create a new setup
 To create a new setup from scratch:

• Select ‘New’ on the ‘File’ menu, or click the ‘New’
icon on the tool bar, then select ‘861’ and click on
‘OK’ or

• Open a Meridian settings file as a starting point
and save it with a new name.

 If you do this, the settings will not necessarily
correspond to the cards that are fitted to your 861.

 To store settings in the 861
 To store the program settings back to the product:

• Select ‘Store to products/Everything’ on the ‘File’
menu, or

• Click the ‘Store’ icon on the tool bar.

Using the Windows 95 program
Move around the 861's settings by clicking on icons in
the left-hand pane of the application. Clicking once on
an icon selects it and displays the corresponding
settings in the right-hand pane. Double-clicking on a
Product, Settings or ‘Back’ icon opens it, and the left-
hand pane changes to display a set of subsidiary icons
– this works much like a directory listing.

As you move around, the title bar reflects your
position in the settings. Settings in the right-hand pane
may be modified by clicking on them and typing a new
value or choosing from a list.

To create a new User Type
To create a new user type:

1 Select the left-hand pane icon for an existing set of
settings (which can be used as a starting point).

2 Hit the ‘Copy as new Type’ button on the toolbar.
This transfers the settings to the clipboard.

This creates a new Type that can be named in its right-
hand pane.

Advanced setup features
To update the 861 built-in software
To change the built-in operating software in the 861’s
flash memory:

1 Select the ‘Owner’ icon for the product. Options for
flash uploading are presented in the ‘Advanced’
tab.

2 In the ‘Product firmware’ box, select the correct
.MFU file from the drop-down list. The list will show
all upload files starting with ‘861’ in the installation
directory. To select an upload that has a different
name, or is in a different directory, use the
‘Browse...’ button. Once the desired firmware has
been selected:

3 Click ‘Upload to product...’ in the ‘Product
firmware’ section.

Note: It can take several minutes to update the
complete flash memory. In some circumstances
screen-savers interfere with serial communications.
We recommend that you disable or extend the time-out
of any screen-savers before trying to upload a file.

Hints and tips for the setup program
• Do not run other applications that use the same

serial port as the Meridian application at the same
time. This may cause a loss of connectivity.
Quitting both applications and restarting should fix
the problem.

• The 861 must be in Standby to communicate with
the PC. If it is taken out of Standby (whether
directly, or using the Comms or MSR) the next
fetch or store operation may fail with a ‘No Current
Session’ error. The operation will normally
succeed if re-tried. If you intend to deliberately
bring the product out of standby while running the
setup application, use the ‘Disconnect products’
option beforehand.

• A maximum of 10 User Types can be uploaded
into a product.

• Each User Type uses 300k of RAM while being
edited. So, if a large number of types are being
edited, the computer must have sufficient memory.

• By default, sources have the same names as the
MSR buttons that will select them. If a source
name is changed, the MSR legend is shown in
brackets after the name.

• Screen-savers. In some circumstances screen-
savers interfere with serial communications. We
recommend that you disable or extend the time-out
of any screen-savers before trying to upload a file.
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 Advanced 861 settings
 Settings with video
 The 861 provides a LipSync feature to allow you to
delay the sound by up to one video frame.

 Some installations require longer delays to
compensate for the delay in video processors. Video
processors like line-doublers may delay the picture by
up to 5 video frames – interfering significantly with the
sound/picture alignment. The 861 allows an overall
Delay setting to compensate for this.
 
 To access this setting, Look under ‘Sources’; select a
source (e.g.LD) and click the ‘Advanced’ tab.
 

 Trigger outputs
 The CO00 computer card in the 861 has three trigger

outputs that can be used to operate ‘Function Select’ or
certain relays. They may be used to trigger amplifier,
video or environmental changes.

 The state of the three outputs is adjusted in the setup
program. Look under ‘Sources’; select a source (e.g.
CD) and click the ‘Advanced’ tab.

 The trigger outputs each provide +12V nominal when
selected 0V when de-selected. Each trigger can supply
up to 50mA.

 Special settings for DTS
 The 861 automatically detects DTS if you play a DTS
CD, LaserDisc or DVD. When the disc starts playing,
the 861 will switch to one of its DTS presets.

 If you subsequently play a different disc – such as a
standard CD or a Dolby Digital LaserDisc – the 861 will
reload another DSP preset like Trifield or Dolby Digital
(AC-3).

 Dolby Digital and MPEG are both ‘flagged’ as non-
audio in the incoming data stream and so devices like
861 or digital/analogue converters (DACs) know not to
play it as normal audio by mistake. (This same method
is used to prevent you playing back CDROMs as audio
in a CD player.) If, for any reason, compressed
streams are played as audio, the result is a loud hiss.

 Like Dolby Digital and MPEG, DTS is a compressed
(non-PCM) signal. DTS streams on the other hand are
not flagged in this way; consequently normal DACs and
decoders have no direct method of preventing you
hearing the compressed stream as a loud hiss.

 The Meridian 861 detects the DTS signal and
switches to a DTS preset as quickly as it can. However,
even the 861 needs a short time to be sure that this
really is DTS. So, when you play a DTS LaserDisc you
may hear the compressed signal as a short burst of
hiss before DTS is identified.  As we have explained,
this is an unavoidable limitation of the way DTS is
delivered, not of the 861. (See ‘DTS Delay’.)

 DTS Delay
 In the setup program, look under ‘Sources’, select a
source (e.g. CD) and click the ‘Advanced’ tab. There is
an additional check-box that allows a short delay to be
added to the audio for that Source.

 Clicking on the box selects it. When this setting is
stored in the 861 it will add a 32ms delay to the audio
for that source. This delay allows the 861 time to detect
a DTS signal before it is played out, and therefore
prevents the short hiss occurring as the disc starts
playing.

 Setting DTS Delay is the ideal and recommended
solution to playing DTS from CD. This setting is not
necessarily recommended for video sources (such as
LaserDisc or DVD) because 32ms audio delay may
affect the Lipsync with the picture. It can be used in
conjunction with the delay setting described in the
‘Advanced settings with Video’ section.

 When you Type the 861, the default settings apply
DTS Delay only to CD, Radio and CDR.

 Reporting
 If you need to report a problem, please provide the
following information:
• Software version and date (select ‘About’ from the

‘Help’ menu).
• The computer hardware and operating system

version in use.
• The exact error message (if any) reported by the

861 or the setup program.
• Any messages displayed on the product.
• A .MSF file containing the settings you were

working on at the time.
• A description of what you think you did to cause

the problem.
 
 
 

 



 Meridian 861 User Request

 

 Please register your 861 with us. We can then send you a complete installation manual
when it is released. You can register in the following ways:
• Complete the details below and either mail or fax this sheet to Meridian Audio in the

UK or Meridian America in Atlanta.
• Register by email by sending the necessary information to list6@meridian-audio.com

Your name  ...........................................................................................................................

Mailing address  ....................................................................................................................
...............................................................................................................................................
...............................................................................................................................................
...............................................................................................................................................
...............................................................................................................................................
...............................................................................................................................................

861 Serial number ................................................................................................................
Extra cards  ...........................................................................................................................

Dealer who supplied it  ..........................................................................................................
...............................................................................................................................................
...............................................................................................................................................
...............................................................................................................................................
...............................................................................................................................................

Comments

Meridian Audio Limited, Stonehill, Stukeley Meadows, Huntingdon, Cambs, PE18 6ED, England
Tel: +44 1480 434334 Fax: +44 1480 432948 Web: http://www.meridian-audio.com

Meridian America Inc., 3800 Camp Creek Parkway, Building 2400, Suite 112, Atlanta GA 30331
Tel: +1 (404) 344-7111 Fax: +1 (404) 346-7111


